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Register and Use the
Inventor Add-In

This chapter describes how to register SimMechanics™ Link software to

the Autodesk® Inventor® CAD platform as an Inventor add-in tool. You
must complete the registration before you can export a CAD assembly in
SimMechanics format.

e “Register SimMechanics Link with Inventor” on page 1-2

® “Constraint-Joint Mapping” on page 1-4

® “Constraint-Joint Mapping in SimMechanics First Generation” on page 1-8

¢ “Configure SimMechanics Link” on page 1-14
e “Export CAD Assembly from Autodesk Inventor” on page 1-16
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Register SimMechanics Link with Inventor

In this section...

“Software Requirements” on page 1-2
“Register SimMechanics Link” on page 1-2
“Register SimMechanics Link with Multiple CAD Installations” on page 1-3

“Unregister SimMechanics Link” on page 1-3

Before you can export a CAD assembly from the Autodesk Inventor® platform,
you must register the SimMechanics Link utility with Inventor. The
registration procedure adds a SimMechanics Link add-in tool to the CAD
platform. Use the add-in tool to export a CAD assembly in SimMechanics
format.

Software Requirements

Registration requires that the following two products be installed on your
computer:

e Inventor

e SimMechanics Link — See “Install and Register SimMechanics Link
Software”

Register SimMechanics Link
To register SimMechanics Link with the CAD platform:

1 Start a new MATLAB® session.
2 At the MATLAB command line, enter smlink_linkinv.

3 MATLAB displays a message stating that linking was successful. You
can close MATLAB.

On startup, the CAD platform displays a SimMechanics Link menu item
in the Add-In menu. The menu item appears only when a CAD assembly
(extension .iam) is open.
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Register SimMechanics Link with Multiple CAD
Installations

If you have multiple Inventor installations on your computer, the command
smlink_linkinv registers SimMechanics Link with all installations.

You can register one SimMechanics Link version as a CAD add-in tool. If you
have multiple SimMechanics Link versions, you must unregister the current
version before registering a new version.

Unregister SimMechanics Link
To unregister the SimMechanics Link add-in from a Inventor installation:

® At the MATLAB command line, enter smlink_unlinkinv.

The command removes the add-in from the Inventor registry. The
SimMechanics Link add-in no longer appears in the menu bar of the CAD
platform.

If you have multiple installations of Inventor on your computer, the
command smlink_unlinkinv removes the SimMechanics Link add-in from
all installations.



1 Register and Use the Inventor® Add-In

Constraint-Joint Mapping

In this section...

“CAD Constraint — SimMechanics Joint Mapping” on page 1-4
“Supported Constraint Entity” on page 1-4
“Supported Constraint Entity Combinations” on page 1-5

“Supported SimMechanics Joints” on page 1-7

CAD Constraint - SimMechanics Joint Mapping

During CAD export, SimMechanics Link maps Inventor constraints between
parts to SimMechanics joints between rigid bodies. CAD constraints and
SimMechanics joints do not follow a one-to-one correspondence — multiple
constraints can map into a single joint. All SimMechanics joints contain a
combination of three joint primitives: Prismatic, Revolute, and Spherical. The
Weld Joint block contains zero joint primitives, and therefore zero degrees of
freedom. The following table identifies the degrees of freedom of each joint
primitive.

Primitive Abbreviation | Motion Type Number of
DoFs

Prismatic P Translational 1

Revolute R Rotational 1

Spherical S Rotational 3

Supported Constraint Entity

Depending on the constraint combination, SimMechanics Link utility
supports the following Inventor constraint entities:

Entity Description
Circle/Arc Circular edge/arc sketch segment*
Ellipse/Arc Elliptical edge/arc sketch segment*
Cone Conical face




Constraint-Joint Mapping

Entity Description

Cylinder Cylindrical face

Line Linear edge/sketch segment/reference axis
Plane Reference plane or planar face

Point Vertex/sketch point/reference point

* A complete circle or ellipse is a special case of a circular or elliptical arc.

Supported Constraint Entity Combinations

The following sections list the constraint-entity combinations that
SimMechanics Link supports for different constraint types.

Note If the SimMechanics Link exporter cannot translate a
constraint—constraint entity combination into a supported SimMechanics
joint with DoF's, it converts the combination into a weld (W) primitive.

Coincident Constraint

The following table identifies supported constraint-entity combinations for
the Coincident constraint. A v indicates the combination is supported.

Constraint-Entity 2

Point | Line | Plane | Cylinder Cone | Circle/Arc

Constraint-Entity)

Point

v

Line

Plane

Cylinder

Cone

Circle/Arc

SSIIENHIENE IR
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Concentric Constraint

The following table identifies supported constraint-entity combinations for
the Concentric constraint. A v indicates the combination is supported.

Constraint Entity 2

Point | Line | Plane | Cylinderr Cone | Circle/Arc
Constraint Point
Entity 1 Line P P
Plane
Cylinder
Cone
Circle/Arc v v v
Distance Constraint
The following table identifies supported constraint-entity combinations for
the Distance constraint. A v indicates the combination is supported.
Constraint Entity 2
Point | Line | Plane | Cylinden Cone | Circle/Arc
Constraint Point v v
Entity 1 Line P
Plane v v v
Cylinder
Cone

Circle/Arc

Angle Constraint
The following table identifies supported constraint-entity combinations for

the Angle constraint. A v indicates the combination is supported.



Constraint-Joint Mapping

Constraint Entity 2

Point | Line | Plane | Cylinder Cone | Circle/Arc
Constraint Point
Entity 1 Line P
Plane v
Cylinder
Cone

Circle/Arc

Supported SimMechanics Joints
The SimMechanics Link utility supports the following SimMechanics

joint-primitive combinations.

Primitive Combination

SimMechanics Block

P Prismatic Joint
PP Rectangular Joint
PPP Cartesian joint

S Spherical joint

R Revolute Joint
PR Cylindrical Joint
PPR Planar Joint
PPPS 6-DOF Joint

W Weld joint

1-7
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Constraint-Joint Mapping in SimMechanics First
Generation

In this section...

“Degrees of Freedom in SimMechanics” on page 1-8

“CAD Constraint — SimMechanics Joint Mapping” on page 1-8
“Supported Constraint Entity” on page 1-9

“Supported Constraint Entity Combinations” on page 1-9
“Supported SimMechanics Joints” on page 1-12

“Limitations” on page 1-13

In Autodesk Inventor, unconstrained parts have six mechanical degrees of
freedom (DoF's) that describe how the parts move with respect to each other.
Of the six degrees of freedom, three are rotational and three are translational.
Applying a constraint between two parts eliminates degrees of freedom
between the two parts. Constraints can remove between zero and six degrees
of freedom.

Degrees of Freedom in SimMechanics

SimMechanics First Generation assigns zero degrees of freedom to an
unconstrained rigid body. Connecting the rigid body to a joint or constraint
block increases the mechanical degrees of freedom available to the rigid body.

Rigid Body Condition First-Generation DoF

Not connected to joints, constraints, | O
or World Frame

Connected to Joints or Constraints | Add degrees of freedom according to
blocks joint or constraint

CAD Constraint - SimMechanics Joint Mapping

During CAD export, SimMechanics Link maps Inventor constraints between
parts to SimMechanics joints between rigid bodies. CAD constraints and
SimMechanics joints do not follow a one-to-one correspondence — multiple



Constraint-Joint Mapping in SimMechanics First Generation

constraints can map into a single joint. All SimMechanics joints contain a
combination of three joint primitives: Prismatic, Revolute, and Spherical. The
Weld Joint block contains zero joint primitives, and therefore zero degrees of
freedom. The following table identifies the degrees of freedom of each joint
primitive.

Primitive Abbreviation | Motion Type Number of
DoFs

Prismatic P Translational 1

Revolute R Rotational 1

Spherical S Rotational 3

Supported Constraint Entity

Depending on the constraint combination, SimMechanics Link utility
supports the following Inventor constraint entities:

Entity Description

Circle/Arc Circular edge/arc sketch segment®
Ellipse/Arc Elliptical edge/arc sketch segment*

Cone Conical face

Cylinder Cylindrical face

Line Linear edge/sketch segment/reference axis
Plane Reference plane or planar face

Point Vertex/sketch point/reference point

* A complete circle or ellipse is a special case of a circular or elliptical arc.

Supported Constraint Entity Combinations

The following sections list the constraint-entity combinations that
SimMechanics Link supports for different constraint types.
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Note If the SimMechanics Link exporter cannot translate a
constraint—constraint entity combination into a supported SimMechanics
joint with DoF's, it converts the combination into a weld (W) primitive.

Coincident Constraint

The following table identifies supported constraint-entity combinations for
the Coincident constraint. A v indicates the combination is supported.

Constraint-Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc

Constraint-Entity)

Point

v

Line

Plane

Cylinder

Cone

Circle/Arc

ASEIENEIENE RN

Concentric Constraint

The following table identifies supported constraint-entity combinations for
the Concentric constraint. A v indicates the combination is supported.

Constraint Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc
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Constraint Point
Entity 1 Line P P
Plane
Cylinder
Cone v
Circle/Arc v v v
Distance Constraint
The following table identifies supported constraint-entity combinations for
the Distance constraint. A v indicates the combination is supported.
Constraint Entity 2
Point | Line | Plane | Cylinder Cone | Circle/Arc
Constraint Point v v
Entity 1 Line P
Plane v v v
Cylinder
Cone

Circle/Arc

Angle Constraint
The following table identifies supported constraint-entity combinations for

the Angle constraint. A v indicates the combination is supported.

Constraint Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc

1-11
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Constraint
Entity 1

Point

Line

Plane

Cylinder

Cone

Circle/Arc

1-12

Supported SimMechanics Joints
The SimMechanics Link utility supports the following SimMechanics

joint-primitive combinations.

Primitive Combination

SimMechanics Block

P Prismatic

PP In-Plane

PPP Custom Joint
PPPR Custom dJoint

S Spherical

R-S Revolute-Spherical
R Revolute

PR Cylindrical

PPR Planar

PPPS Six-DoF

R-R Revolute-Revolute
S-S Spherical-Spherical
A Weld

Tips for Specific Constraints

¢ The point-point coincident constraint maps onto a spherical joint.



Constraint-Joint Mapping in SimMechanics First Generation

® The point-point distance constraint maps onto a spherical-spherical
massless connector.

Limitations
The following limitation applies to CAD export from Inventor.

Weld is Default Joint

If the SimMechanics Link utility fails to translate a CAD constraint, a Weld
joint replaces the constraint.

Restriction on Point-Point Distance Mate

For SimMechanics Link to successfully map the CAD point-point distance
constraint onto a SimMechanics spherical-spherical massless connector, the
constraint must not connect to any other constraint.

1-13
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Configure SimMechanics Link

In this section...

“SimMechanics Link Settings” on page 1-14

“Dialog Box” on page 1-14

SimMechanics Link Settings

The SimMechanics Link add-in tool provides a Settings option. Use the
option to specify:

e Tolerances — linear, angular, and relative
To access the Settings parameters:

1 Open the assembly to export.

2 In the menu bar, click Add-Ins > Settings.
The Settings dialog box opens.

Dialog Box

The dialog box contains two panes:

¢ Assembly Tolerances — Specifies linear, angular, and relative tolerances
of exported assembly.

SimMechanics Link Export Settings 23
Linear tolerance:  1e-005 millimeters
Angular tolerance: 1e-005 radians

Relative rounding  1z-012
tolerance:

oK | | Cancel

1-14



Configure SimMechanics™ Link

Enter the export tolerances for a CAD assembly. During the conversion of
CAD constraints to SimMechanics joints, SimMechanics Link compares the

spacing, alignment, and relative numerical errors with the export tolerances.

Field Default Purpose Defaylbnit
Value
Linear 1e-005 Smallest le-5 | Unit used
tolerance significant length in assembly.
difference The default is
mm
Angular 1e-005 Smallest le-5 | Unit used
tolerance significant angle in assembly.
difference The default is
rad
Relative 1e-012 Smallest le-12 | —
roundoff significant
tolerance relative numerical
difference

1-15
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Export CAD Assembly from Autodesk Inventor

In this section...
“Export CAD Assembly” on page 1-16

“CAD Assembly Export Errors” on page 1-17

Export CAD Assembly
To export a CAD assembly:

1 In the menu bar of the CAD platform, click Add-Ins.

2 Click Export SimMechanics <Generation>, where <Generation>
identifies the desired SimMechanics generation.

Assemble  Design  Model Inspect Tools Manage View Environments  Get Started

Settings.. Help Demos About SimMechanics Link

Export SimMechanics First Generation...

Export SimMechanics Second Generation...

L
Export current assembly to XML file for use in SimMechanics
Second Generation

3 In the dialog box, enter the file name and select a convenient file directory.

SimMechanics

SimMechanics Link generates:

® One XML import file.

The file contains the structure and parameters of the CAD assembly.
During CAD import, SimMechanics uses the structure and parameters to
autogenerate a SimMechanics model.

e A set of STL files.

Each STL file specifies the 3-D surface geometry of one CAD part. The
STL files are not required to generate the model, but they are required for
visualization. If you import a model without the STL files, during model
update and simulation Mechanics Explorer displays a blank screen.
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CAD Assembly Export Errors

In the event that a CAD export error occurs:

¢ A dialog box displays an error message. The message identifies the CAD
constraints that SimMechanics Link could not translate into joints.

¢ SimMechanics Link generates an error log file. Refer to the log for more
information about the CAD export error. The error message identifies the
name and location of an error log file.

¢ SimMechanics Link generates the XML file. You can import the file to
generate a valid SimMechanics model, but the model may not accurately
represent the original CAD assembly.

¢ [If SimMechanics Link cannot export one or more STL files, the error
message identifies the CAD parts associated with the STL files.

1-17
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Register and Use the Creo
Add-In

This chapter describes how to register SimMechanics Link software to the
Creo™ (Pro/ENGINEER®) CAD platform as a Pro/TOOLKIT application. You
must complete the registration before you can export a CAD assembly in
SimMechanics format.

e “Register SimMechanics Link with Creo” on page 2-2

® “Constraint-Joint Mapping” on page 2-8

e “Constraint-Joint Mapping in SimMechanics First Generation” on page
2-13

® “Configure SimMechanics Link” on page 2-19
e “Export CAD Assembly” on page 2-22
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Register SimMechanics Link with Creo

In this section...

“Software Requirements” on page 2-2

“Registration Overview” on page 2-2

“Add Registration Text to Registry File” on page 2-3

“Add Registry File Path to Configuration File” on page 2-4

“SimMechanics Link Registration Example” on page 2-6

“Unregister SimMechanics Link” on page 2-7

Once you have successfully downloaded and installed the SimMechanics Link
utility, you must complete registration with the CAD platform. Registration
adds the SimMechanics Link utility to the CAD platform as an add-in tool. In
earlier versions of Pro/ENGINEER software, the add-in tool appears directly
on the toolbar. In Creo software, the add-in tool appears as a menu item in
the Tools menu.

Registration is manual. You must create or modify registry and configuration

files for the CAD platform.

Software Requirements
Registration requires that two products be installed on your computer:

¢ CAD platform — Creo or Creo predecessor Pro/ ENGINEER

e SimMechanics Link

Registration Overview
The complete registration procedure contains two steps:
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O &
File ~ Home

&

New  Open

B
Common Folders

[H] in Session

Data

Tl

SelectWorking  Model System Customize  Play
Display Colors  Ribbon  Trail Fie

Directory

Step Purpose For more
information, see...

1. Add registration text | Registers the ® “Add Registration

to registry file SimMechanics Link Text to Registry File”
utility with the CAD on page 2-3
platform.

2. Add registry file path | Allow the CAD * “Add Registry

to configuration file platform to load the File Path to
SimMechanics Link Configuration File”
add-in at startup. on page 2-4

For information about registry and configuration files, consult the
documentation that accompanies your CAD platform installation.

Registration adds a SimMechanics Link menu item to the CAD platform. The
following figure shows the menu item in a Creo installation.

Note In Pro/ENGINEER, the SimMechanics Link add-in appears as a
separate item in the menu bar.

Creo Parametric

O & B

SimMechanics Link »
' =00 ' SimMechanics First Generation

Setlings SimMechanics Second Generation %

Settings * N Utilties + TOOLKIT Help
Demo SimMechanics Second Generation
About SimMechanics Link Export current assembly to an XML
P . o file for use in SimMechanics Second
L [#[2 &&  ntipitwewiw pto.comicommunityicreofindex htm et
@ PTC - Creo 1.0 - Start x @ 3DModelSpace x ] |

Add Registration Text to Registry File

Registration requires access to registry file protk.dat. The registry file
should exist in the protoolkit directory of your CAD platform. If you cannot
locate the file, create a new registry file. Save the file in a convenient directory
as <filename>.dat, where <filename> is a name of your choice.

To add registration text to the registry file:

2-3



2 Register and Use the Creo™ Add-In

1 Open the Pro/TOOLKIT application registry file. In the registry file, each
line contains a predefined parameter followed by a value.

2 Add the SimMechanics Link registration text appropriate to your CAD
platform.

Creo, Pro/ENGINEER Wildfire 4.0 and Later Versions

In the registry file, insert:

NAME SimMechanics Link

STARTUP dl11

EXEC_FILE $matlabroot/bin/arch/cl_proe2sm.dll

TEXT_DIR $matlabroot/toolbox/physmod/smlink/cad_systems/proe/
UNICODE_ENCODING false

END

Pro/ENGINEER Wildfire 3.0 and Earlier Versions

As above. Omit the line UNICODE_ENCODING false:

NAME SimMechanics Link

STARTUP dl11

EXEC_FILE $matlabroot/bin/arch/cl_proe2sm.dll

TEXT_DIR $matlabroot/toolbox/physmod/smlink/cad_systems/proe/
END

3 Save the registry file.

Add Registry File Path to Configuration File

The configuration file of your CAD platform must contain the location of the
registry file. This step allows the CAD platform to load the SimMechanics
Link utility as an add-in tool on startup.

The configuration file has name config.pro. Look for the file in the following
directories.

Creo

<creoroot>/<arch>/Common Files/F000/text
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e <creoroot> is the root directory of your Creo installation.

e <arch> is the CAD platform architecture. For example, x64 for 64-bit
architectures.

Pro/ENGINEER

<proeroot>/<arch>/text

® <proeroot> is the root directory of your Pro/ENGINEER installation.

e <arch> is the CAD platform architecture. For example, x64 for 64-bit
architectures.

Note The directory of file config.pro may differ from the directories
provided.

If you cannot locate the configuration file for your CAD platform, create a new
file. Use a text editor of your choice. Save the new file as <filename>.pro,
where <filename> is a name of your choice. You must save the file in one

of two folder:

e CAD platform folder
e Startup folder

To find the startup folder, open the CAD platform and click File > Open.

1 Open the configuration file for your CAD platform.

2 At the bottom of the configuration file, add a new line with the absolute
path to the registry file:

toolkit_registry_file <absolute_path>/<registry_filename>.dat

toolkit_registry file is a predefined parameter that specifies the
location of the registry file. <absolute path> is the absolute path to the
registry file. <registry filename> is the name of the registry file.

2-5



2 Register and Use the Creo™ Add-In

SimMechanics Link Registration Example

This example illustrates the registration procedure for a Pro/ENGINEER
CAD platform. In the example, you create new registry and configuration files:

¢ The registry file provides registration information for the SimMechanics
Link utility.

¢ The configuration platform provides the location of the registry file. This
step allows the CAD platform can load the SimMechanics Link add-in on
startup.

After successful completion of the example, the CAD platform loads
SimMechanics Link as an add-in at startup.

Create Registry File
To create the registry file:

1 Create directory C:\data
2 With a text editor, create a new file.
3 In the new file, enter:

NAME SimMechanics Link

STARTUP dll

EXEC_FILE C:\Program Files\MATLAB\bin\win32\cl_proe2sm.dll

TEXT_DIR C:\Program Files\MATLAB\toolbox\physmod\smlink\cad_systems\proe\text
UNICODE_ENCODING false

END

4 Save the file in directory C:\data with name smlink.dat. This is the

registry file that contains the registration information for SimMechanics
Link.

Create Configuration File
To create the configuration file:

1 With a text editor, create a new file.

2-6



Register SimMechanics™ Link with Creo™

2 In the new file, enter:

toolkit_registry_file c:\data\smlink.dat

3 Save the file as config.pro in one of two directories:

e CAD installation directory:

<proeroot>/<arch>/text

proeroot is the root of the Pro/ENGINEER installation. For example,

C:/Program Files/Proe

arch is the architecture of the CAD installation. For example, x64.

e CAD startup directory — the directory a CAD session starts in.

Unregister SimMechanics Link
To unregister SimMechanics Link with either Creo or Pro/ENGINEER CAD

platforms, follow these steps.

If you...

Then...

Created a new registry file for your
CAD platform

Delete the registry file path from the
configuration file

Added registration test to an existing
registry file

Delete the registration text from the
registry file
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Constraint-Joint Mapping

In this section...

“CAD Constraint — SimMechanics Joint Mapping” on page 2-8
“Supported Constraint Entity” on page 2-8
“Supported Constraint Entity Combinations” on page 2-9

“Supported SimMechanics Joints” on page 2-11

CAD Constraint - SimMechanics Joint Mapping

During CAD export, SimMechanics Link maps Creo constraints between
parts to SimMechanics joints between rigid bodies. CAD constraints and
SimMechanics joints do not follow a one-to-one correspondence — multiple
constraints can map into a single joint. All SimMechanics joints contain a
combination of three joint primitives: Prismatic, Revolute, and Spherical. The
Weld Joint block contains zero joint primitives, and therefore zero degrees of
freedom. The following table identifies the degrees of freedom of each joint
primitive.

Primitive Abbreviation | Motion Type Number of
DoFs

Prismatic P Translational 1

Revolute R Rotational 1

Spherical S Rotational 3

Supported Constraint Entity

Depending on the constraint combination, SimMechanics Link utility
supports the following Creo constraint entities:

Entity Description
Circle/Arc Circular edge/arc sketch segment*
Ellipse/Arc Elliptical edge/arc sketch segment*
Cone Conical face




Constraint-Joint Mapping

Entity Description

Cylinder Cylindrical face

Line Linear edge/sketch segment/reference axis
Plane Reference plane or planar face

Point Vertex/sketch point/reference point

* A complete circle or ellipse is a special case of a circular or elliptical arc.

Supported Constraint Entity Combinations

The following sections list the constraint-entity combinations that

SimMechanics Link supports for different constraint types.

Note If the SimMechanics Link exporter cannot translate a
constraint—constraint entity combination into a supported SimMechanics
joint with DoF's, it converts the combination into a weld (W) primitive.

Coincident Constraint

The following table identifies supported constraint-entity combinations for

constraints:

¢ Align without offset
e Mate without offset

Point on Line

Edge on Surface

Point on Surface

A v indicates the combination is supported.

Constraint-Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc
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Constraint-Entity)

Point

Line

Plane

Cylinder

Cone

Circle/Arc

ANEIENEIENE RN

Insert Constraint
The following table identifies supported constraint-entity combinations for

the Insert constraint. A v indicates the combination is supported.

Constraint Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc

Constraint

Point

Entity 1

Line

Plane

Cylinder

Cone

Circle/Arc

Align or Mate Constraint with Translational Offset
The following table identifies supported constraint-entity combinations for
the Align or Mate constraints with translational offset. A v indicates the

combination is supported.

Constraint Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc
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Constraint
Entity 1

Point v

Line

Plane v

Cylinder

Cone

Circle/Arc

Align or Mate with Rotational Offset

The following table identifies supported constraint-entity combinations
for the Align or Mate constraints with rotational offset. A v indicates the

combination is supported.

Constraint Entity 2

Point

Line

Plane | Cylinder Cone | Circle/Arc

Constraint
Entity 1

Point

Line

Plane

Cylinder

Cone

Circle/Arc

Supported SimMechanics Joints
The SimMechanics Link utility supports the following SimMechanics

joint-primitive combinations.

Primitive Combination

SimMechanics Block

P Prismatic Joint
PP Rectangular Joint
PPP Cartesian joint

2-11



2 Register and Use the Creo™ Add-In

2-12

Primitive Combination

SimMechanics Block

S Spherical joint
R Revolute Joint
PR Cylindrical Joint
PPR Planar Joint
PPPS 6-DOF Joint

w Weld joint
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Constraint-Joint Mapping in SimMechanics First
Generation

In this section...

“Degrees of Freedom in SimMechanics” on page 2-13

“CAD Constraint — SimMechanics Joint Mapping” on page 2-13
“Supported Constraint Entity” on page 2-14

“Supported Constraint Entity Combinations” on page 2-14
“Supported SimMechanics Joints” on page 2-17

“Limitations” on page 2-18

In Pro/ENGINEER, unconstrained parts have six mechanical degrees of
freedom (DoF's) that describe how the parts move with respect to each other.
Of the six degrees of freedom, three are rotational and three are translational.
Applying a constraint between two parts eliminates degrees of freedom
between the two parts. Constraints can remove between zero and six degrees
of freedom.

Degrees of Freedom in SimMechanics

SimMechanics First Generation assigns zero degrees of freedom to an
unconstrained rigid body. Connecting the rigid body to a joint or constraint
block increases the mechanical degrees of freedom available to the rigid body.

Rigid Body Condition First-Generation DoF

Not connected to joints, constraints, | O
or World Frame

Connected to Joints or Constraints | Add degrees of freedom according to
blocks joint or constraint

CAD Constraint - SimMechanics Joint Mapping

During CAD export, SimMechanics Link maps Pro/ENGINEER constraints
between parts to SimMechanics joints between rigid bodies. CAD constraints
and SimMechanics joints do not follow a one-to-one correspondence —
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multiple constraints can map into a single joint. All SimMechanics joints
contain a combination of three joint primitives: Prismatic, Revolute, and
Spherical. The Weld Joint block contains zero joint primitives, and therefore
zero degrees of freedom. The following table identifies the degrees of freedom
of each joint primitive.

Primitive Abbreviation | Motion Type Number of
DoFs

Prismatic P Translational 1

Revolute R Rotational 1

Spherical S Rotational 3

Supported Constraint Entity

Depending on the constraint combination, SimMechanics Link utility
supports the following Creo constraint entities:

Entity Description

Circle/Arc Circular edge/arc sketch segment®
Ellipse/Arc Elliptical edge/arc sketch segment*

Cone Conical face

Cylinder Cylindrical face

Line Linear edge/sketch segment/reference axis
Plane Reference plane or planar face

Point Vertex/sketch point/reference point

* A complete circle or ellipse is a special case of a circular or elliptical arc.

Supported Constraint Entity Combinations

The following sections list the constraint-entity combinations that
SimMechanics Link supports for different constraint types.
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Note If the SimMechanics Link exporter cannot translate a
constraint—constraint entity combination into a supported SimMechanics
joint with DoF's, it converts the combination into a weld (W) primitive.

Coincident Constraint

The following table identifies supported constraint-entity combinations for
constraints:

Align without offset

Mate without offset

Point on Line

Edge on Surface

Point on Surface

A v indicates the combination is supported.

Constraint-Entity 2
Point | Line | Plane | Cylinderr Cone | Circle/Arc
Constraint-Entity| Point v
1 Line
Plane v
Cylinder v
Cone v
Circle/Arc v v

Insert Constraint

The following table identifies supported constraint-entity combinations for
the Insert constraint. A v indicates the combination is supported.
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Constraint Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc

Constraint Point

Entity 1 Line

Plane

Cylinder

Cone

Circle/Arc

Align or Mate Constraint with Translational Offset

The following table identifies supported constraint-entity combinations for
the Align or Mate constraints with translational offset. A v indicates the

combination is supported.

Constraint Entity 2
Point | Line | Plane | Cylinder Cone | Circle/Arc

Constraint Point v v
Entity 1 Line P

Plane v v v

Cylinder

Cone

Circle/Arc

Align or Mate with Rotational Offset

The following table identifies supported constraint-entity combinations
for the Align or Mate constraints with rotational offset. A v indicates the

combination is supported.
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Constraint Entity 2

Point

Line

Plane | Cylinderr Cone | Circle/Arc

Constraint
Entity 1

Point

Line

Plane

Cylinder

Cone

Circle/Arc

Supported SimMechanics Joints
The SimMechanics Link utility supports the following SimMechanics

joint-primitive combinations.

Primitive Combination

SimMechanics Block

P Prismatic

PP In-Plane

PPP Custom dJoint
PPPR Custom dJoint

S Spherical

R-S Revolute-Spherical
R Revolute

PR Cylindrical

PPR Planar

PPPS Six-DoF

R-R Revolute-Revolute
S-S Spherical-Spherical
' Weld
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Limitations
The following limitation applies to CAD export from Pro/ENGINEER.

Weld is Default Joint
If the SimMechanics Link utility fails to translate a CAD constraint, a Weld
joint replaces the constraint.
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Configure SimMechanics Link

In this section...

“SimMechanics Link Settings” on page 2-19

“Dialog Box” on page 2-19

SimMechanics Link Settings

The SimMechanics Link add-in tool provides a Settings option. Use the
option to specify:

e Tolerances — linear, angular, and relative

¢ Coordinate systems to export
To access the Settings parameters:

1 Open the assembly to export.
2 In the menu bar, click Tools > SimMechanics Link.

3 Click Settings.

The Settings dialog box opens.
Dialog Box

The dialog box contains two panes:

* Assembly Tolerances — Specifies linear, angular, and relative tolerances
of exported assembly.

e Export Coordinate Systems — Determines what coordinate systems to
export.
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Assembly Tolerances
Linear tolerance: |1 000000e-05
Angular tolerance: | 1.000000e-05

Relative tolerance: | 1.000000e-12

Export Coordinate Systems

@ Do not export coordinate systems
Export only C5s with this prefox:

SMLINK_

0K

Cancel

Assembly Tolerances
Enter the export tolerances for a CAD assembly. During the conversion of
CAD constraints to SimMechanics joints, SimMechanics Link compares the
spacing, alignment, and relative numerical errors with the export tolerances.

Field Default Value Purpose Defdl.““l‘lil‘
Linear 1e-005 Smallest significant | 1le-5 | Units
tolerance length difference used
in
assembly
Angular 1e-005 Smallest significant | 1le-5 | Units
tolerance angle difference used
n
assembly
Relative 1e-012 Smallest significant | le-12 | —
roundoff relative numerical
tolerance difference
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Export Coordinate Systems
Specify which reference coordinate systems to export. The coordinate systems

are independent of constraints between parts. Options include:
* Do not export coordinate systems — Export no coordinate systems.

¢ Export only CSs with this prefix — Export only coordinate systems
with the specified name prefix. If the prefix field is empty, SimMechanics
Link exports all reference coordinate systems.
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Export CAD Assembly

New  Open Select Working  Model System Customize  Play

B (4 & =
File ~ Home
S -~
L] &= T
Directory
Dat;
B
Common Folders
[M] in Session

In this section...

“Export CAD Assembly” on page 2-22
“CAD Assembly Export Errors” on page 2-23

Export CAD Assembly
To export a CAD assembly:

1 In the menu bar of the CAD platform, click Tools.

2 ClickSimMechanics Link > Export.

Creo Parametric

ON & 8

3
= Simblechancs Link Export L SimMechanics First Generation
Dieplay Colors  Rbion_| TadFie Setlings SimMechanics Secand Generation N

Settings ~ ] Utilties ~ TOOLKIT Help

Demo SimMechanics Second Generation
About SimMechanics Link Export current assembly to an XML
file for use in SimMechanics Second
Generation

Y

@ PTC - Creo 1.0 - Start x (@ 3DModelSpace x ¥

3 Click SimMechanics <Generation>, where <Generation> identifies the
desired SimMechanics generation.

4 In the dialog box, enter the file name and select a convenient file directory.

SimMechanics Link generates:

® One XML import file.

The file contains the structure and parameters of the CAD assembly.
During CAD import, SimMechanics uses the structure and parameters to
autogenerate a SimMechanics model.

e A set of STL files.

Each STL file specifies the 3-D surface geometry of one CAD part. The
STL files are not required to generate the model, but they are required for



Export CAD Assembly

visualization. If you import a model without the STL files, during model
update and simulation Mechanics Explorer displays a blank screen.

CAD Assembly Export Errors

In the event that a CAD export error occurs:

e A dialog box displays an error message. The message identifies the CAD
constraints that SimMechanics Link could not translate into joints.

®* SimMechanics Link generates an error log file. Refer to the log for more
information about the CAD export error. The error message identifies the
name and location of an error log file.

¢ SimMechanics Link generates the XML file. You can import the file to
generate a valid SimMechanics model, but the model may not accurately
represent the original CAD assembly.

¢ [f SimMechanics Link cannot export one or more STL files, the error
message 1dentifies the CAD parts associated with the STL files.
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Register and Use
SolidWorks Add-In

This chapter describes how to register SimMechanics Link software to the
SolidWorks® CAD platform as a SolidWorks add-in. You must complete the
registration before you can export a CAD assembly in SimMechanics format.

“Register SimMechanics Link with SolidWorks” on page 3-2

“Mates and Joints” on page 3-6

“Mate-Joint Mapping in SimMechanics First Generation” on page 3-10
“Configure SimMechanics Link” on page 3-17

“Export CAD Assembly from SolidWorks Software” on page 3-21
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Register SimMechanics Link with SolidWorks

In this section...

“Software Requirements” on page 3-2
“Register SimMechanics Link” on page 3-2
“Add SimMechanics Link to SolidWorks Menu bar” on page 3-3

“Register SimMechanics Link with Multiple SolidWorks Installations” on
page 3-4

“SimMechanics Link Menu” on page 3-4

“Unregister SimMechanics Link” on page 3-4

Before you can export a CAD assembly from the SolidWorks platform,
you must register the SimMechanics Link utility with SolidWorks. The
registration procedure adds a SimMechanics Linkadd-in tool to the CAD
platform. Use the add-in tool to export a CAD assembly in SimMechanics
format.

Software Requirements

Registration requires that the following two products be installed on your
computer:

e SolidWorks

¢ SimMechanics Link — See “Install and Register SimMechanics Link
Software”

Register SimMechanics Link
To register SimMechanics Link with the CAD platform:

1 Start a new MATLAB session.
2 At the MATLAB command line, enter smlink_linksw.

3 MATLAB displays a message stating that linking was successful. You
can close MATLAB.
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Add SimMechanics Link to SolidWorks Menu bar

SimMechanics Link is now registered as a SolidWorks add-in tool. To use the
tool, select the tool as an active add-in:

1 Open SolidWorks.
2 In the menu bar, select Tools > Add-Ins.

3 In the Add-Ins dialog box, select SimMechanics Link.

-

22 |

Add-Ins

Active Add-ins | start Up |
= SolidWorks Premium Add-ins
[7138) 3D Instant Website

[C] & CircuitWorks

7] 2 Featureworks

[T]E8 Photawarks

[C]§#l scanTo3D

[[] & SolidWarks Design Checker
[7] & solidWarks Mation

[T]1EE salidWaorks Routing

[ solidWorks Simulation

[[]  solidWarks Taolbox

D‘Eﬂ SolidWorks Toolbox Browser
DW SolidWarks Utilities

|:| SolidWorks Warkgroup POM 2010
FIET Toltnalyst

Bl SolidWorks Add-ins

[ Autotrace
[7]  solidWorks XPS Driver

= Other Add-ins
simMechanics Link

a0

00| OOOCOcoooEoO

=

[ oK l [ Cancel l -

The menu bar of the CAD platform displays a SimMechanics Link menu
item.

Wnliderks . Fie Edit WView Insert Tools Window SimMechanics Link Help

3-3



3 Register and Use SolidWorks® Add-In

Register SimMechanics Link with Multiple SolidWorks
Installations

If you have multiple SolidWorks installations on your computer, the command
smlink_linksw registers SimMechanics Link with all installations.

To add SimMechanics Link to the CAD platform menu bar, you must still
open each installation of SolidWorks, and select SimMechanics Link from
the Tools > Add-Ins menu.

You can register one SimMechanics Link version as a CAD add-in tool. If you
have multiple SimMechanics Link versions, you must remove the current
registration before adding a new one.

SimMechanics Link Menu

Following registration, the menu bar of the CAD platform displays a
SimMechanics Link menu item. The menu item appears only when a CAD
assembly (extension .sldasm) is open.

@SnlidWo{ks . File Edit WView Insert Tools Window |SimMedmanics Link | Help | |__] e @ B I:% '_l B E‘ —

s

LY el
'.f?v -

5 .Ecport SirmMechanics First Generation...
Settings... SimMechanics Second Generation...
Help ;
Custornize Menu
Demo

About SimMechanics Link...

/ Customize Menu

Unregister SimMechanics Link
To unregister the SimMechanics Link add-in from a SolidWorks installation:

e At the MATLAB command line, enter smlink_unlinksw.

The command removes the add-in from the SolidWorks registry. The
SimMechanics Link add-in no longer appears in the menu bar of the CAD
platform.
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If you have multiple installations of SolidWorks on your computer, the
command smlink_unlinksw removes the SimMechanics Link add-in from
all installations.
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Mates and Joints

In this section...

“Mates and Mate Entities” on page 3-6

“SimMechanics Joints” on page 3-8

Mates and Mate Entities

In a SolidWorks assembly, you specify geometric relationships between parts
using mates. Each mate applies a kinematic constraint between geometric
entities of different parts. Geometric entities include points, lines, and
surfaces.

A nut and bolt system provides an example of a mated system. To center the
two parts on a common axis, you might add a concentric mate between the
cylindrical surfaces of the bolt and the nut hole. This mate restricts motion to
translation along the common axis as well as rotation about that same axis.

During CAD Import, SimMechanics converts mates between parts into joints
between rigid bodies. In the nut-and-bolt example, SimMechanics might
translate the concentric mate between the two cylindrical surfaces into a
revolute joint between frames on the nut and bolt rigid bodies.

SimMechanics supports most mates and mate entities in SolidWorks. The
supported entities are:

e (Circle/arc

e Cone

Cylinder

e Line

Plane

Point
The supported mates are:

* Angle
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Coincident

¢ Concentric

® Distance

e Parallel

® Perpendicular

Supported mates are valid only for certain entity pairs. The table shows the
entity pairs compatible with the supported mates. This table is symmetric

with respect to the diagonal row. For conciseness, the redundant half of the
table 1s omitted.

Mate Entity 2

CirclefAre Cone Cylinder Line Plane Point

CirclefArc Ct, Cc

Cone Ct, Cc Ct, Ce, P
2 | Cylinder Ct, Ce Ct, Ce Ct, Ce, PI
G P
. - - A Ct, Pr
ﬁ Ling Cc Cc Pl
=
Plane ci Ct, D, Pr, A Ct Ce,
- Pl o, Pr, Pl
Foint D Ct, D
A—Angle Cc— Concentric €t — Coincident
D — Distance Fl — FParallel Pr — Perpendicular

CAD assemblies with other mate-entity combinations may present issues
during CAD import into SimMechanics. By default, SimMechanics replaces
each unsupported mate with a rigid connection. Parts joined by a rigid
connection have zero degrees of freedom with respect to each other. You can
replace these rigid connections with the appropriate joints once CAD Import
1s complete.
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SimMechanics Joints

SimMechanics joint and constraint blocks are the functional equivalent of
SolidWorks mates. They apply between frames the kinematic relationships
that determine how they can move. For example, a revolute joint aligns
the Z axes of two frames while keeping their origins coincident. In this
configuration, the two frames have one rotational degree of freedom (DoF)
about the common Z axis.

Joints are combinations of joint primitives, the building blocks that provide
the joint its degrees of freedom. These primitives vary according to the
number and type of DoFs that they provide. SimMechanics includes three
joint-primitive types:

¢ Prismatic primitive — Joint primitive with one translational DoF
® Revolute primitive — Joint primitive with one rotational DoF

® Spherical primitive — Joint primitive with three concurrent rotational
DoF's

The spherical primitive differs from a set of three revolute primitives in the
way it represents 3-D rotation:

® Spherical primitive — Represents rotation in three dimensions as one
rotation about an arbitrary 3-D axis.

® Three revolute primitives — Represents rotation in three dimensions as
a sequence of three rotations about different axes. During rotation, two
axes can become aligned, causing the joint to lose one rotational degree of
freedom. This phenomenon, named after the gimbal devices in which they
often occur,

The table summarizes the joint primitives present in each SimMechanics
joint. In this table, P, R, and S denote prismatic, revolute, and spherical joint
primitives. Note that the weld joint, which provides zero degrees of freedom,
has no joint primitives.

Joint Block Joint Primitives
6-DOF Joint P-P-P-S
Bearing Joint P-R-R-R
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Joint Block

Joint Primitives

Bushing Joint P-P-P-R-R-R
Cartesian Joint P-P-P
Cylindrical Joint P-R
Gimbal Joint P-P-R
Pin Slot Joint P-R
Planar Joint P-P-R
Prismatic Joint P
Rectangular Joint P-P
Revolute Joint R
Spherical Joint S
Telescoping Joint P-S
Universal Joint R-R
Weld Joint N/A

During CAD Import, SimMechanics translates the mates in a SolidWorks
assembly into an equivalent set of joints. For example, a coincident mate
between a point-point entity pair maps onto a spherical joint in SimMechanics.
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Mate-Joint Mapping in SimMechanics First Generation

In this section...

“Degrees of Freedom in SimMechanics” on page 3-10
“CAD Mate — SimMechanics Joint Mapping” on page 3-10
“Supported Constraint Entity” on page 3-11

“Supported Constraint Entity Combinations” on page 3-11
“Supported SimMechanics Joints” on page 3-15

“Limitations” on page 3-16

In SolidWorks, unmated parts have six mechanical degrees of freedom (DoF's)
that describe how the parts can move with respect to each other. Of the six
degrees of freedom, three are rotational and three are translational. Applying
a mate between two parts eliminates degrees of freedom between the two
parts. Mates can remove between zero and six degrees of freedom.

Degrees of Freedom in SimMechanics

SimMechanics assigns six degrees of freedom to an unconstrained rigid body.
The unconstrained rigid body behaves as a free body — it can rotate and
translate, about or along three mutually orthogonal axes. The following table
lists the degrees of freedom of a rigid body in different configurations.

Rigid Body Condition Degrees of Freedom

Not connected to joints, constraints, | O
or World Frame

Connected to Joints or Constraints | Add degrees of freedom as specified
blocks by joint or constraint

CAD Mate - SimMechanics Joint Mapping

During CAD export, SimMechanics Link maps SolidWorks mates between
parts to SimMechanics joints between rigid bodies. CAD mates and
SimMechanics joints do not follow a one-to-one correspondence — multiple
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mates can map into a single joint. All SimMechanics joints contain a
combination of three joint primitives: Prismatic, Revolute, and Spherical. The
Weld Joint block contains zero joint primitives, and therefore zero degrees of
freedom. The following table identifies the degrees of freedom of each joint
primitive.

Primitive Abbreviation | Motion Type Number of
DoFs

Prismatic P Translational 1

Revolute R Rotational 1

Spherical S Rotational 3

Supported Constraint Entity

Depending on the constraint combination, SimMechanics Link utility
supports the following Inventor constraint entities:

Entity Description

Circle/Arc Circular edge/arc sketch segment®
Ellipse/Arc Elliptical edge/arc sketch segment*

Cone Conical face

Cylinder Cylindrical face

Line Linear edge/sketch segment/reference axis
Plane Reference plane or planar face

Point Vertex/sketch point/reference point

* A complete circle or ellipse is a special case of a circular or elliptical arc.

Supported Constraint Entity Combinations

The following sections list the constraint-entity combinations that
SimMechanics Link supports for different constraint types.
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Note If the SimMechanics Link exporter cannot translate a
constraint—constraint entity combination into a supported SimMechanics
joint with DoF's, it converts the combination into a weld (W) primitive.

Coincident Constraint

The following table identifies supported constraint-entity combinations for
the Coincident constraint. A v indicates the combination is supported.

Mate-Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc

Mate-Entity 1

Point v

Line

Plane

Cylinder

Cone

Circle/Arc

s|slsls

Concentric Mate

The following table identifies supported constraint-entity combinations for

the Concentric mate. A v indicates the combination is supported.

Mate-Entity 2

Point

Line

Plane

Cylinder

Cone

Circle/Arc
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Mate-Entity 1

Point

Line

Plane

Cylinder

Cone

Circle/Arc

Perpendicular Mate
The following table identifies supported constraint-entity combinations for
the Perpendicular mate. A v indicates the combination is supported.

Mate-Entity 2

Point

Line

Plane | Cylinder

Cone

Circle/Arc

Mate-Entity 1

Point

Line

Plane

Cylinder

Cone

Circle/Arc

Parallel Mate

The following table identifies supported constraint-entity combinations for
the Parallel mate. A v indicates the combination is supported.

Mate-Entity 2

Point

Line

Plane | Cylinder

Cone

Circle/Arc
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Mate-Entity 1

Point

Line

Plane

Cylinder v

Cone v

Circle/Arc

Distance Mate
The following table identifies supported constraint-entity combinations for
the Distance mate. A v indicates the combination is supported.

Mate-Entity 2

Mate-Entity 1

Point | Line | Plane | Cylinder Cone | Circle/Arc
Point v v
Line v
Plane 4 v v
Cylinder
Cone
Circle/Arc

Angle Mate

The following table identifies supported constraint-entity combinations for
the Angle mate. A v indicates the combination is supported.

Mate-Entity 2

Point | Line | Plane | Cylinder Cone | Circle/Arc
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Mate-Entity 1

Point

Line v

Plane v

Cylinder

Cone

Circle/Arc

Supported SimMechanics Joints

The SimMechanics Link utility supports the following SimMechanics
joint-primitive combinations.

Primitive Combination SimMechanics Block
P Prismatic

PP In-Plane

PPP Custom Joint
PPPR Custom dJoint

S Spherical

R-S Revolute-Spherical
R Revolute

PR Cylindrical

PPR Planar

PPPS Six-DoF

R-R Revolute-Revolute
S-S Spherical-Spherical
W Weld
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Tips for Specific Mates

® The point-point coincident mate maps onto a spherical joint.

® The point-point distance mate maps onto a spherical-spherical massless
connector.

Limitations
The following limitation applies to CAD export from SolidWorks.

Weld is Default Joint

If the SimMechanics Link utility fails to translate a CAD constraint, a Weld
joint replaces the constraint.

Restriction on Point-Point Distance Mate

For SimMechanics Link to successfully map the CAD point-point distance
mate onto a SimMechanics spherical-spherical massless connector, the mate
must not connect to any other mates.



Configure SimMechanics™ Link

Configure SimMechanics Link

In this section...

“SimMechanics Link Settings” on page 3-17

“Dialog Box” on page 3-17

SimMechanics Link Settings
The SimMechanics Link add-in tool provides a Settings option. Use the

option to specify:
e Tolerances — linear, angular, and relative

¢ Coordinate systems to export
To access the Settings parameters:

1 Open the assembly to export.

2 In the menu bar, click SimMechanics Link > Settings.

The Settings dialog box opens.

Dialog Box

The dialog box contains four panes:
e Message — Describes the purpose of the dialog box. The Message box
1s Inactive.

¢ Solve Subassemblies Using — Determines whether to export a
subassembly as a rigid or flexible system.

¢ Assembly Tolerances — Specifies linear, angular, and relative tolerances
of exported assembly.

¢ Export Coordinate Systems — Determines what coordinate systems to
export.
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To...

Save your settings and close the settings dialog box
Close the settings dialog box without saving your settings

Open online SimMechanics Link help



Configure SimMechanics™ Link

Solve Subassemblies Using
Select how to export CAD subassemblies.

¢ Component properties — Treat rigid subassemblies as rigid, and flexible
subassemblies as flexible.

¢ Flexible settings — Treat all subassemblies as flexible. This setting
applies does not affect the original CAD assembly.

Make Subassemblies Rigid or Flexible in SolidWorks

Subassemblies can be rigid or flexible. Rigid subassemblies behave as a single
rigid body. Flexible subassemblies behave as a multibody subsystem. To
make a subassembly rigid or flexible:

1 Right-click the subassembly.
2 Click Component > Properties.
3 Select between Flexible and Rigid options.
Select Rigid only if the motion between subassembly parts is not important

in SimMechanics.

Assembly Tolerances

Enter the export tolerances for a CAD assembly. During the conversion of
CAD constraints to SimMechanics joints, SimMechanics Link compares the
spacing, alignment, and relative numerical errors with the export tolerances.

Field Default Purpose Defquhnit

Value
Linear 1e-005 Smallest significant le-5| meter (m)
tolerance length difference
Angular 1e-005 Smallest significant le-5| radian (rad)
tolerance angle difference
Relative 1e-012 Smallest significant le-12 —
roundoff relative numerical
tolerance difference
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Export Coordinate Systems

Specify which reference coordinate systems to export. The reference
coordinate systems are independent of mates between parts.Options include:

* Do not export coordinate systems — Export no coordinate systems.

¢ Export only CSs with this prefix — Export only coordinate systems
with the specified name prefix. If the prefix field is empty, SimMechanics
Link exports all reference coordinate systems.



Export CAD Assembly from SolidWorks® Software

Export CAD Assembly from SolidWorks Software

In this section...
“Export CAD Assembly” on page 3-21
“CAD Assembly Export Errors” on page 3-22

Export CAD Assembly
To export a CAD assembly:

1 In the menu bar of the CAD platform, click SimMechanics Link.

2 Click Export > SimMechanics <Generation>, where <Generation>
identifies the desired SimMechanics generation.

Eﬂ,SnlidWo{ks I File Edit WView Insert Tools Window |SimMed‘|anics Link | Help ‘Jl.l__] e @ B I:% '_l B E‘ —

e Export SimMechanics First Generation...
e - R IFIRI > = | SmMechan _
- NT~ il v I
% e, ST Hel

o ot (Defau P Customize Menu

BE Demo

Annotations
Sensors About SimMechanics Link...

Front
(\B\ Troc:]n / Customize Menu

3 In the dialog box, enter the file name and select a convenient file directory.

® B

SimMechanics Link generates:

® One XML import file.

The file contains the structure and parameters of the CAD assembly.
During CAD import, SimMechanics uses the structure and parameters to
autogenerate a SimMechanics model.

e A set of STL files.

Each STL file specifies the 3-D surface geometry of one CAD part. The
STL files are not required to generate the model, but they are required for
visualization. If you import a model without the STL files, during model
update and simulation Mechanics Explorer displays a blank screen.
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CAD Assembly Export Errors

In the event that a CAD export error occurs:

¢ A dialog box displays an error message. The message identifies the CAD
constraints that SimMechanics Link could not translate into joints.

¢ SimMechanics Link generates an error log file. Refer to the log for more
information about the CAD export error. The error message identifies the
name and location of an error log file.

¢ SimMechanics Link generates the XML file. You can import the file to
generate a valid SimMechanics model, but the model may not accurately
represent the original CAD assembly.

¢ [If SimMechanics Link cannot export one or more STL files, the error
message identifies the CAD parts associated with the STL files.
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smlink_linkinv

Purpose

Syntax

Description

Output
Arguments

Definitions

See Also

How To

Register and link SimMechanics Link software as Autodesk Inventor
add-in

smlink_linkinv

smlink_linkinv registers and links SimMechanics Link software as an
add-in to Autodesk Inventor. Execute this function before you attempt
to use SimMechanics Link software with Autodesk Inventor.

A message indicating that the registration and linking have worked,
with the location of the add-in module, if registration and linking
succeed.

An error message describing the failure, if registration and linking
do not succeed.

Linking is associating a version of a CAD platform with a SimMechanics
Link installation.

Depending on the CAD platform and if you use the Windows® operating
system, linking a CAD platform can involve registering one of the
executable SimMechanics Link libraries with Windows.

Registering is entering an executable module or library in the Windows
registry.

smlink_unlinkinv

+ “Install and Register SimMechanics Link Software”



smlink linksw

Purpose
Syntax

Description

Output
Arguments

Definitions

See Also

How To

Register and link SimMechanics Link software as SolidWorks add-in
smlink_linksw

smlink_linksw registers and links SimMechanics Link software as an
add-in to SolidWorks. Execute this function before you attempt to use
SimMechanics Link software with SolidWorks.

A message indicating that the linking has worked, with the location of
the add-in module, if registration and linking succeed.

An error message describing the failure, if registration and linking

do not succeed.

Linking is associating a version of a CAD platform with a SimMechanics
Link installation.

Depending on the CAD platform and if you use the Windows operating
system, linking a CAD platform can involve registering one of the
executable SimMechanics Link libraries with Windows.

Registering is entering an executable module or library in the Windows
registry.

smlink_unlinksw

+ “Install and Register SimMechanics Link Software”



smlink unlinkinv

Purpose
Syntax

Description

Output
Arguments

Definitions

See Also

How To

Unlink SimMechanics Link software as Autodesk Inventor add-in
smlink_unlinksw

smlink_unlinksw unlinks SimMechanics Link software as an add-in to
Autodesk Inventor.

A message indicating that the unlinking has worked, with the location
of the add-in module, if unlinking succeeds.

An error message describing the failure, if unlinking does not succeed.

Linking is associating a version of a CAD platform with a SimMechanics
Link installation.

Depending on the CAD platform and if you use the Windows operating
system, linking a CAD platform can involve registering one of the
executable SimMechanics Link libraries with Windows.

Registering is entering an executable module or library in the Windows
registry.

smlink_linkinv

+ “Install and Register SimMechanics Link Software”



smlink unlinksw

Purpose
Syntax

Description

Output
Arguments

Definitions

See Also

How To

Unlink SimMechanics Link software as SolidWorks add-in
smlink_unlinksw

smlink_unlinksw unlinks SimMechanics Link software as an add-in
to SolidWorks.

A message indicating that the unlinking has worked, with the location
of the add-in module, if unlinking succeeds.

An error message describing the failure, if unlinking does not succeed.
Linking is associating a version of a CAD platform with a SimMechanics
Link installation.

Depending on the CAD platform and if you use the Windows operating
system, linking a CAD platform can involve registering one of the
executable SimMechanics Link libraries with Windows.

Registering is entering an executable module or library in the Windows
registry.

smlink_linksw

+ “Install and Register SimMechanics Link Software”



smlink unlinksw
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pmit_add_cadcs

Purpose

Description

Input
Arguments

See Also

Add coordinate system to handle object of PmitCadModelH class

PmitError = pmit_add_cadcs(PmitCadModelH pmitCadModelH,
PmitCadCSH pmitCadCSH) returns an error status PmitError.

With pmit_add_cadcs, you can add a coordinate system to a handle
object of PmitCadModelH class that represents an API CAD model.
pmitCadModelH

Handle object of PmitCadModelH class representing an API CAD model

pmitCadCSH

Handle object of PmitCadCSH class representing a coordinate system on
an API CAD model

PmitCadCSH | pmit_create cadcs | PmitError



pmit_add_constrain

Purpose

Syntax

Description

Input
Arguments

See Also

Add constraint to handle object of PmitCadModelH class

PmitError = pmit_add_constrain(PmitCadModelH pmitCadModelH,
PmitConstrainH pmitConstrainH)

PmitError = pmit_add_constrain(PmitCadModelH pmitCadModelH,
PmitConstrainH pmitConstrainH) returns an error status PmitError.

With pmit_add_constrain, you can add a constraint to a handle object
of PmitCadModelH class that represents an API CAD model.
pmitCadModelH

Handle object of PmitCadModelH class representing an API CAD model

pmitConstrainH

Handle object of PmitConstrainH class representing an API CAD model
constraint

PmitCadModelH | PmitConstrainH | PmitError



pmit_add_refincadmodel

Purpose

Syntax

Description

Input
Arguments

See Also

Add object of PmitCadModelRefH class to object of PmitCadModelH class

PmitError = pmit_add_refincadmodel(PmitCadModelH pmitCadModelH,
PmitCadModelRefH pmitCadModelrefH)

PmitError = pmit_add_refincadmodel (PmitCadModelH
pmitCadModelH, PmitCadModelRefH pmitCadModelrefH) returns an
error status PmitError.

With pmit_add_refincadmodel, you can add an object of
PmitCadModelRefH class to an object of PmitCadModelH class, in order
to reference a CAD model in an API CAD model hierarchy.
pmitCadModelH

Handle object of PmitCadModelH class representing an API CAD model

pmitCadModelrefH

Handle object of PmitCadModelRefH class referencing a CAD model
in an API CAD model hierarchy

PmitCadModelH | PmitCadModelRefH | PmitError



pmit_add_refincomp

Purpose
Syntax

Description

Input
Arguments

See Also

Add object of PmitCadModelRefH class at end of object of
PmitAssemCompH class

PmitError = pmit_add_refincomp (PmitAssemCompH pmitAssemComp,
PmitCadModelRefH pmitCadModelrefH)

PmitError = pmit_add_refincomp (PmitAssemCompH
pmitAssemComp, PmitCadModelRefH pmitCadModelrefH) returns an
error status PmitError.

With pmit_add_refincomp, you can add an object of PmitCadModelRefH
class at the end of an object of PmitAssemCompH class, in order to
reference an element in an API CAD hierarchy. You construct the full
reference with a chain of objects of PmitCadModelRefH class. Make the
chain as long as needed to reach the desired element in the hierarchy.

pmitAssemComp

Handle object of PmitAssemCompH class representing a component in
an API CAD model

pmitCadModelrefH

Handle object of PmitCadModelRefH class referencing a CAD model
in an API CAD model hierarchy

PmitAssemCompH | PmitCadModelRefH | PmitError



PmitAssemCompH

Purpose

Description

See Also

Handle object type to represent component in API CAD model

PmitAssemCompH is a C language opaque type.

A variable of this type is a handle object created when you instantiate
a SimMechanics Link API object representing an API CAD assembly
component.

pmit_add refincomp | pmit_create_assemcomp
pmit_create_assemcomp_fromstr | pmit_create_constrain
| PmitError



PmitCad2SMH
|

Purpose Handle object type to represent API-to-XML translator

Description PmitCad2SMH is a C language opaque type.

A variable of this type is a handle object created when you instantiate
a SimMechanics Link API object that translates an API CAD model
into XML.

See Also pmit_create_cad2sm | PmitError | pmit_set_tolerances |
pmit_write_xml



PmitCadCSH

Purpose Handle object type to represent coordinate system

Description PmitCadCSH is a C language opaque type.

A variable of this type is a handle object created when you add a
coordinate system to a SimMechanics Link API object representing
an API CAD model.

See Also pmit_add cadcs | pmit_create_cadcs | PmitError



PmitCadModelH
|

Purpose Handle object type to represent API CAD model

Description PmitCadModelH is a C language opaque type.

A variable of this type is a handle object created when you instantiate a
SimMechanics Link API object representing an API CAD model of an
assembly or assembly part.

See Also pmit_add constrain | pmit_add_refincadmodel |
pmit cadmodel setfilename | pmit_cadmodelref getcadmodel
| pmit_create_assemcomp_fromstr | pmit_create_cad2sm |
pmit_create_cadmodel | pmit_create_cadmodelref | PmitError
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Purpose

Description

See Also

Handle object type to reference a CAD model in API CAD model
hierarchy

PmitCadModelRefH is a C language opaque type.

A variable of this type is a handle object created when you instantiate
a SimMechanics Link API object referencing an API CAD model
component.

pmit _add refincadmodel | pmit_add_refincomp
pmit_cadmodelref_getcadmodel | pmit_create_cadmodelref
| PmitError | pmit_get reffixedstatus |

pmit _get refflexiblestatus | pmit_set reffixedstatus
pmit_set_refflexiblestatus



pmit_cadmodel_setfilename

Purpose
Syntax

Description

Input
Arguments

See Also

Specify body geometry file name for handle object of PmitCadModelH
class

PmitError = pmit_cadmodel_setfilename (PmitCadModelH pmitCadModelH,
const char* fileName)

PmitError = pmit_cadmodel_setfilename(PmitCadModelH
pmitCadModelH, const char* fileName) returns an error status
PmitError.

With pmit_cadmodel_ setfilename, specify the STL body geometry
file name for a handle object of PmitCadModelH class representing an
API CAD model.

The body geometry file carries no units. This body geometry is
interpreted with the units defined for the API session.

pmitCadModelH
Handle object of PmitCadModelH class representing an API CAD model

fileName

String specifying STL body geometry file name

PmitCadModelH | PmitError | pmit_set _units
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pmit_cadmodelref_getcadmodel
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Purpose
Syntax

Description

Input
Arguments

Output
Arguments

See Also

Get object of PmitCadModelH class from children of object of
PmitCadModelRefH class

PmitError = pmit_cadmodelref_getcadmodel(PmitCadModelH* pmitCadModelHO
ut, PmitCadModelRefH cadModelRefH)

PmitError = pmit_cadmodelref_getcadmodel (PmitCadModelH*
pmitCadModelHO ut, PmitCadModelRefH cadModelRefH) returns an
error status PmitError.

With pmit_cadmodelref getcadmodel, you can get an object of
PmitCadModelH class that represents an API CAD model from whatever
is referenced by an object of PmitCadModelRefH class.

cadModelRefH

Handle object of PmitCadModelRefH class referencing a CAD model

in an API CAD model hierarchy

pmitCadModelHOut

Handle object of PmitCadModelH class representing an API CAD model

PmitCadModelH | PmitCadModelRefH | PmitError



pmit_connectto_matlab

Purpose Connect to MATLAB session

Syntax PmitError = pmit_connectto_matlab()

Description PmitError = pmit_connectto_matlab() returns an error status
PmitError.

See Also pmit_disconnectfrom matlab | PmitError | pmit_open_demo |

pmit_open_help
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PmitConstrainH
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Purpose

Description

See Also

Handle object type to represent constraint

PmitConstrainH is a C language opaque type.

A variable of this type is a handle object created when you add a
constraint to a SimMechanics Link API object representing an API
CAD model.

pmit_add constrain | PmitConstrainType | pmit_create_constrain
| PmitError



PmitConstrainType

Purpose Enumerated type for specifying constraint type

Description PmitConstrainType is a C language enumerated type.

A variable of this type is defined when you create a constraint in a
SimMechanics Link API CAD model.

These are the variable’s allowed enumerated values.

Value Constraint Type
PMIT_CON_UNKNOWN = -1 Unknown
PMIT_CON_COINCIDENT =0 Coincident points
PMIT_CON_CONCENTRIC Concentric circles or circular arcs
PMIT_CON_PERPEND Perpendicular lines or planes
PMIT_CON_PARALLEL Parallel lines or planes
PMIT_CON_TANGENT Tangent curves or surfaces
PMIT_CON_DISTANCE Fixed distance between points
PMIT_CON_ANGLE Fixed angle between lines
PMIT_CON_FULL Fully fixing one body’s position and
orientation with respect to another
body.
Kinematically equivalent to a rigid
weld.
See Also pmit_add_constrain | PmitConstrainH | pmit_create_constrain |
PmitError
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pmit_create_assemcomp

Purpose Create object of PmitAssemCompH class

Syntax PmitError = pmit_create_assemcomp (PmitAssemCompH* const pmitAssemCompH
Out)

Description PmitError = pmit_create_assemcomp(PmitAssemCompH* const

pmitAssemCompH Out) returns an error status PmitError.

With pmit_create_assemcomp, you can create an object of
PmitAssemCompH class in order to reference child models in the
hierarchy of other API CAD models.

Output pmitAssemCompHOut

Arguments Handle object of PmitAssemCompH class representing a component in

an API CAD model

See Also PmitAssemCompH | PmitError
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pmit_create_assemcomp_fromsir

Purpose
Syntax

Description

Input
Arguments

Output
Arguments

See Also

Create object of PmitAssemCompH class

PmitError = pmit_create_assemcomp_fromstr(PmitAssemCompH*
const pmitAssemCompHOut, const char* compName,
PmitCadModelH parentModelH) returns an error status PmitError.

With pmit_create_assemcomp_fromstr, you can create, from its string
representation, an object of PmitAssemCompH class that represents an
API CAD model component.

compName

String specifying name of component

parentModelH
Handle object of class PmitCadModelH representing an API CAD model

pmitAssemCompHOut

Handle object of PmitAssemCompH class representing a component in
an API CAD model

PmitAssemCompH | PmitCadModelH | PmitError
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pmit_create_cad2sm
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Purpose

Syntax

Description

Input
Arguments

Create object of PmitCad2SMH class

PmitError = pmit_create_cad2sm(PmitCad2SMH* const pmitCad2SMHOut,
PmitCadModelH const pmitCadModelH, const char* createdUsing,
const char* createdFrom, const char* createdOn,
const char* createdBy, const char* name)

PmitError = pmit_create_cad2sm(PmitCad2SMH* const
pmitCad2SMHOut, PmitCadModelH const pmitCadModelH, const
char* createdUsing, const char* createdFrom, const char*
createdOn, const char* createdBy, const char* name) returns
an error status PmitError.

With pmit_create_cad2sm, you can create an object of PmitCad2SMH

class to represent an API-to-XML CAD model translator. The header
information that you specify in the inputs is written to the final XML
file.

pmitCadModelH

Handle object of PmitCadModelH class representing an API CAD model

createdUsing

String naming the exporter

createdFrom

String naming the source CAD platform or other external application

createdOn

String specifying date that the object was created

createdBy

String specifying name of user creating the object

name



pmit_create_cad2sm

String naming the assembly model

Output pmitCad2SMHOut

Arguments Handle object of PmitCad2SMH class representing an API-to-XML

translator object
See Also PmitCad2SMH | PmitCadModelH | PmitError | pmit_write_xml

Tutorials + “A Custom Exporter Module Example”
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pmit_create_cadcs

Purpose

Syntax

Description

Input
Arguments

Output
Arguments

5-20

Create object of PmitCadCSH class

PmitError = pmit_create_cadcs(PmitCadCSH* const pmitCadCSHOut,
const char* name, const char* nodeID, double rotation[9],
double trans[3])

PmitError = pmit_create_cadcs(PmitCadCSH* const
pmitCadCSHOut, const char* name, const char* nodeID, double
rotation[9], double trans[3]) returns an error status PmitError.

With pmit_create_cadcs, you can create an object of PmitCadCSH class
to represent a coordinate system in an API CAD model.

name

String naming the coordinate system

nodelD

String uniquely identifying the coordinate system for associativity
purposes

rotation

Double-type real rotation 9-vector specifying rotational transformation
of the origin of this coordinate system with respect to its parent CAD
model.

trans

Double-type real 3-vector specifying translation of the origin of this
coordinate system with respect to its parent CAD model.
pmitCadCSHOut

Handle object of PmitCadCSH class representing a coordinate system in
an API CAD model



pmit_create_cadcs

Definitions Orthogonal Matrix

A matrix R is orthogonal if it satisfies the matrix multiplication rule
R™R=R*R T =1, where 1 is the identity matrix.

Rotational Transformation: Rotation Matrix and Rotation
Vector

The rotation vector input is a 9-vector, defined from the 3-by-3
orthogonal rotation matrix R, that represents the rotational orientation
of a CAD model component with respect to its parent CAD model.

Ri1 Rip Rys
R=|Ry; Ryy Ry3
R3; Rzp R

You define the rotation 9-vector column-wise:

rotation = [R(1,1) R(2,1) R(3,1) R(1,2) R(2,2) R(3,2)
- R(1,3) R(2,3) R(3,3)]

See Also pmit_add_cadcs | PmitCadCSH | PmitError
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pmit_create_cadmodel
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Purpose

Syntax

Description

Input
Arguments

Create object of PmitCadModelH class

PmitError = pmit_create_cadmodel(PmitCadModelH* const pmitCadModelHOut
, const char* name, double mass, const double inertia[6],
const double cg[3], double volume, double sarea,
const char* fileName, const PmitVisMatProp* matprops)

PmitError = pmit_create_cadmodel (PmitCadModelH* const
pmitCadModelHOut , const char* name, double mass, const
double inertia[6], const double cg[3], double volume,
double sarea, const char* fileName, const PmitVisMatProp*
matprops) returns an error status PmitError.

With pmit_create_cadmodel, you can create an object of
PmitCadModelH class to represent an API CAD model.

The body geometry file specified by fileName carries no units. This
body geometry is interpreted with the units defined for the API session.

name

String naming the CAD assembly or part model

mass

Double-type real number specifying the mass of the assembly or part

inertia

Double-type real 6-vector specifying the rotational inertia of the
assembly or part. See “Definitions” on page 5-23.

<9

Double-type real 3-vector specifying the position of the center of gravity
of the assembly or part

volume

Double-type real number specifying the volume of the assembly or part



pmit_create_cadmodel

Output
Arguments

Definitions

See Also

sarea

Double-type real number specifying the surface area of the assembly
or part

fileName

String specifying STL body geometry file name

matprops

Structure of PmitVisMatProp class specifying the visualizable
properties of the assembly or part

pmitCadModelHOut
Handle object of PmitCadModelH class representing an API CAD model

Inertia Tensor and Inertia Vector

The inertia vector input is a 6-vector defined from the 3-by-3 symmetric
inertia tensor [ that depends on the part’s mass distribution:

Iy Lig I3
I=|1Iy Iy Ip3 |,

I3; I3p Igg
where I,, = I,,, I, = I, etc.

You define the inertia 6-vector as:

inertia = [I(1,1) I(2,2) I(3,3) I(1,2) I(3,1) I(2,3)]

PmitCadModelH | PmitError | pmit_set units | PmitVisMatProp
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pmit_create_cadmodelref
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Purpose

Syntax

Description

Input
Arguments

Create object of PmitCadModelRefH class

PmitError = pmit_create_cadmodelref (PmitCadModelRefH* const pmitCadMod
elRefHOut, const char* name, const char* nodelD,
PmitCadModelH pmitCadModelH,
double rotation[9], double trans[3], double scale, int isFlexible,
int isFixed, const PmitVisMatProp* matprops)

PmitError = pmit_create_cadmodelref (PmitCadModelRefH* const
pmitCadMod elRefHOut, const char* name, const char* nodelD,
PmitCadModelH pmitCadModelH, double rotation[9], double
trans[3], double scale, int isFlexible, int isFixed, const
PmitVisMatProp* matprops) returns an error status PmitError.

With pmit_create_cadmodelref, you can create an object of
PmitCadModelRefH class to reference a CAD model in an API CAD
model hierarchy.

name

String specifying name of component instance

nodelD

String specifying unique identity of model component within parent
hierarchy. This identity must be unique within the full model.
pmitCadModelH

Handle object of PmitCadModelH class representing an API CAD
model. This is the same model referenced by the output object
pmitCadModelRefHOuUt, an object of PmitCadModelRefH class.

rotation

Double-type real rotation 9-vector specifying rotational transformation
of the origin of this CAD model with respect to its parent CAD model.
See “Definitions” on page 5-25.



pmit_create_cadmodelref

Output
Arguments

Definitions

trans

Double-type real 3-vector specifying translation of the origin of this
CAD model with respect to its parent CAD model.

scale

Double-type real number specifying overall length scaling of this
instance of the model. A value of 1 means no overall scaling.
isFlexible

Integer-type flag specifying whether component is rigid or nonrigid.
A value of 0 means the component is rigid; a value of 1 means the
component is nonrigid.

isFixed

Integer-type flag specifying whether component is welded or not to its
attachment point in the assembly. A value of 0 means the component
1s not welded; a value of 1 means the component is welded. See
“Definitions” on page 5-25.

matprops

Structure of type PmitVisMatProp for defining visualized material
properties of the machine

pmitCadModelRefHOut

Handle object of PmitCadModelRefH class referencing a CAD model
in an API CAD model hierarchy

Orthogonal Matrix

A matrix R is orthogonal if it satisfies the matrix multiplication rule
R™R = R*R T =1, where 1 is the identity matrix.
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See Also

Rotational Transformation: Rotation Matrix and Rotation
Vector

The rotation vector input is a 9-vector, defined from the 3-by-3
orthogonal rotation matrix R, that represents the rotational orientation
of a CAD model component with respect to its parent CAD model.

Ry1 Ry Rys
R=|Ry; Ryy Ry3
R3; Rzy R

You define the rotation 9-vector column-wise:

rotation = [R(1,1) R(2,1) R(3,1) R(1,2) R(2,2) R(3,2)
R(1,3) R(2,3) R(3,3)]
Flexible Model

A flexible or nonrigid model is made of components that can move with
respect to one another.

An inflexible or rigid model is made of components that cannot move
with respect to one another.

Fixed Model
A fixed model cannot move relative to the ground of the assembly model.

A nonfixed model can move relative to the ground of the assembly
hierarchy.

PmitCadModelH | PmitCadModelRefH | PmitError | PmitVisMatProp



pmit_create_constrain

Purpose
Syntax

Description

Input
Arguments

Create object of PmitConstrainH class

PmitError = pmit_create_constrain(PmitConstrainH* const
pmitConstrainhOut, const char* name, PmitConstrainType
type, PmitAssemCompH bodyi1Comp, PmitAssemCompH body2Comp,
PmitGeomType body1Type, PmitGeomType body2Type, const
double bodyiLoc, const double bodyi1Axis, const double
body2Loc, const double body2Axis) returns an error status
PmitError.

With pmit_create_constrain, you can create an object of
PmitConstrainH class to represent a constraint in an APT CAD model.

For a complete specification of these inputs, see “Definitions” on page
5-28.
name

String naming the constraint

type

Handle object of PmitConstrainType class to represent constraint type
in an API CAD model

body1Comp

Handle object of PmitAssemCompH class to represent first constrained
body in an API CAD model

body2Comp

Handle object of PmitAssemCompH class to represent second constrained
body in an API CAD model

body1Type
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Output
Arguments

Definitions

Handle object of PmitGeomType class to represent the geometry of first
constrained body in an API CAD model

body2Type

Handle object of PmitGeomType class to represent the geometry of
second constrained body in an API CAD model

body1Loc

Double-type 3-vector specifying the spatial location of body 1

body1Axis

Double-type 3-vector specifying the spatial orientation of the axis of
body 1

body2Loc

Double-type 3-vector specifying the spatial location of body 2

body2Axis

Double-type 3-vector specifying the spatial orientation of the axis of
body 2

pmitConstrainhOut

Handle object of PmitConstrainH class to represent a constraint in
an API CAD model

Constraint

A constraint imposes a restriction on how two component bodies can
move relative to one another.

You define a constraint by an axis through a point oriented and located,
respectively, with respect to body 1.

Body Specification

To impose a constraint, specify the two bodies by their:



pmit_create_constrain

e Component handles

e Component body geometry type handles

Locations in space. The location of body 2 is a translation with respect
to the coordinate origin of the CAD model representing body 1.

® Axis directions in space . The axis of body 2 is a direction with respect
to the coordinate axes of the CAD model representing body 1.

See Also PmitAssemCompH | PmitConstrainH | PmitConstrainType | PmitError
| PmitGeomType
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pmit_disconnectfrom_matlab

Purpose Disconnect from MATLAB session

Syntax PmitError = pmit_disconnectfrom_matlab()

Description PmitError = pmit_disconnectfrom_matlab() returns an error status
PmitError.

See Also pmit_connectto _matlab | PmitError
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PmitError

Purpose Enumerated type for error status

Description PmitError is a C language enumerated type.

A variable of this type is defined whenever you call any SimMechanics
Link API function.

These are the variable’s allowed enumerated values.

Value Error Type

PMIT_NO_ERROR =0 No error

PMIT GENERIC FAIL Function call failure not otherwise specified

PMIT_CAD_MODEL_NOTSET API representation of machine not defined

PMIT_XML_DOM_ERROR XML error

PMIT_UNHANDLED_CONSTRAIN Constraint translation error

PMIT_INVALID CON_COMPS

PMIT_UNSUPPORTED_INERTIA UNIT Mass or inertia unit specified that is not
supported by API

PMIT_COULDNOT_CONNECTTO_MATLAB Failure to connect to MATLAB
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Purpose

Description

See Also

Enumerated type for specifying geometry of component

PmitGeomType is a C language enumerated type.

A variable of this type is defined when you create a component in a
SimMechanics Link API CAD model.

These are the variable’s allowed enumerated values.

Value Geometry Type
PMIT_GEO_UNKNOWN = -1 Unknown
PMIT_GEO_POINT =0 Point
PMIT_GEO_LINE Line
PMIT_GEO_PLANE Plane

PMIT_GEO CYL Cylinder
PMIT_GEO_CONE Cone
PMIT_GEO_CIRCLE Circle

pmit_create_constrain | PmitError



pmit_get_reffixedstatus

Purpose

Syntax

Description

Input
Arguments

Output
Arguments

Definitions

See Also

Get fixed status of CAD model

PmitError = pmit_get_reffixedstatus(int* fixedstatusOut,
const PmitCadModelRefH cadModelRefH)

PmitError = pmit_get_reffixedstatus(int* fixedstatusOut,
const PmitCadModelRefH cadModelRefH) returns an error status
PmitError.

With pmit_get_reffixedstatus, you can get the fixed status of a CAD
model referenced by an object of PmitCadModelRefH class.
cadModelRefH

Handle object of PmitCadModelRefH class referencing a CAD model

in an API CAD model hierarchy

fixedstatusOut

Integer flag indicating if the model is fixed or not. A value of 0 means
the model is not fixed. A value of 1 means the model is fixed. See
“Definitions” on page 5-33.

Fixed Model

A fixed model cannot move relative to the ground of the assembly model.

A nonfixed model can move relative to the ground of the assembly
hierarchy.

PmitCadModelRefH | PmitError
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pmit_get_refflexiblestatus

Purpose

Syntax

Description

Input
Arguments

Output
Arguments

Definitions

See Also

5-34

Get flexible status of CAD model

PmitError = pmit_get_refflexiblestatus(int* flexstatusOut,
const PmitCadModelRefH cadModelRefH)

PmitError = pmit_get_refflexiblestatus(int* flexstatusOut,
const PmitCadModelRefH cadModelRefH) returns an error status
PmitError.

With pmit_get_refflexiblestatus, you can get the flexible status of a
CAD model referenced by an object of PmitCadModelRefH class.

cadModelRefH

Handle object of PmitCadModelRefH class referencing a CAD model
in an API CAD model hierarchy

flexstatusOut

Integer flag indicating if the model is flexible or not. A value of 0 means
the model is inflexible, or rigid. A value of 1 means the model is flexible,
or nonrigid. “Definitions” on page 5-34.

Flexible Model

A flexible or nonrigid model is made of components that can move with
respect to one another.

An inflexible or rigid model is made of components that cannot move
with respect to one another.

PmitCadModelRefH | PmitError



PmitLengthUnit

Purpose Enumerated type for specifying length unit in API session

Description PmitLengthUnit is a C language enumerated type.

You can define a variable of this type globally when you start a

SimMechanics Link API session.

These are the variable’s allowed enumerated values.

Value Length Unit Type
PMIT_LU_UNKNOWN = -1 Unknown
PMIT_LU M=0 Meter
PMIT_LU_CM Centimeter
PMIT_LU_MM Millimeter
PMIT_LU_KM Kilometer
PMIT_LU_IN Inch
PMIT_LU_FT Foot
PMIT_LU_MI Mile
PMIT_LU_YD Yard

See Also PmitError | PmitMassUnit | pmit_set_units
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PmitMassUnit

Purpose Enumerated type for specifying mass unit in API session

Description PmitMassUnit is a C language enumerated type.

You can define a variable of this type globally when you start a
SimMechanics Link API session.

These are the variable’s allowed enumerated values.

Value Mass Unit Type
PMIT_MU_UNKNOWN = -1 Unknown
PMIT_MU_KG =0 Kilogram
PMIT_MU_G Gram
PMIT_MU_MG Milligram
PMIT MU _LBM Pound (mass)
PMIT_MU_0Z Ounce
PMIT_MU_SLUG Slug

See Also PmitError | PmitLengthUnit | pmit_set units
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PmitObjectH
|

Purpose Handle object type to represent any API object

Description PmitObjectH is a C language opaque type.

You can define a variable of this type for any object created by the
SimMechanics Link API.

See Also PmitError | pmit_release object
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Purpose
Syntax

Description

See Also

Open SimMechanics Link examples in MATLAB Help browser
PmitError = pmit_open_demo()

PmitError = pmit_open_demo() returns an error status PmitError.

This function is equivalent to the MATLAB command:

demo('matlab','simmechanics link')

demo | pmit_connectto_matlab | PmitError | pmit_open_help



pmit_open_help

Purpose
Syntax

Description

Input
Arguments

See Also

Open product documentation in MATLAB Help browser

PmitError = pmit_open_help(const char* helpItem)

PmitError pmit_open_help(const char* helpItem) returns an
error status PmitError.

This function causes MATLAB to issue the command:

doc StringValue
StringValue is the value of the string helpItem.

helpltem

String specifying the product documentation item to display in the
MATLAB Help browser

doc | pmit_connectto_matlab | PmitError | pmit_open_demo
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Purpose
Syntax

Description

Input
Arguments

See Also

Release character buffer returned by API function
PmitError = pmit_release_buffer(char** buffer)

PmitError = pmit_release_buffer(char** buffer) returns an error
status PmitError.

buffer

String specifying the name of the buffer that you want to release

PmitError | pmit_release object



pmit_release_object

Purpose
Syntax

Description

Input
Arguments

See Also

Release object used by API session
PmitError = pmit_release_object(PmitObjectH objectH)

PmitError = pmit_release_object(PmitObjectH objectH) returns
an error status PmitError.

objectH

Handle object of PmitObjectH class representing the API CAD object
that you want to release

PmitError | PmitObjectH | pmit_release_buffer
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pmit_set_reffixedstatus

Purpose Set fixed status of CAD model

Syntax PmitError = pmit_set_reffixedstatus(PmitCadModelRefH cadModelRefH,
int status)

Description PmitError = pmit_set_reffixedstatus(PmitCadModelRefH
cadModelRefH, int status) returns an error status PmitError.

With pmit_set_reffixedstatus, you can set the fixed status of a CAD
model referenced by an object of PmitCadModelRefH class.

Input cadModelRefH

Arguments Handle object of PmitCadModelRefH class referencing a CAD model
in an API CAD model hierarchy
status

Integer flag indicating if the model is fixed or not. A value of 0
means the model is not fixed. A value of 1 means the model is fixed.
“Definitions” on page 5-42.

Definitions Fixed Model
A fixed model cannot move relative to the ground of the assembly
hierarchy.
A nonfixed model can move relative to the ground of the assembly
hierarchy.

See Also PmitCadModelRefH | PmitError
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pmit_set_refflexiblestatus

Purpose Set flexible status of CAD model

Syntax PmitError = pmit_set_refflexiblestatus(PmitCadModelRefH cadModelRefH,
int status)

Description PmitError = pmit_set_refflexiblestatus(PmitCadModelRefH
cadModelRefH, int status) returns an error status PmitError.

With pmit_set_refflexiblestatus, you can set the flexible status of a
CAD model referenced by an object of PmitCadModelRefH class.

Input cadModelRefH
Arguments Handle object of PmitCadModelRefH class referencing a CAD model
within an API CAD model hierarchy

status

Integer flag indicating if the model is flexible or not. A value of 0 means
the model is inflexible, or rigid. A value of 1 means the model is flexible,
or nonrigid. “Definitions” on page 5-43.

Definitions Flexible Model

A flexible or nonrigid model is made of components that can move with
respect to one another.

An inflexible or rigid model is made of components that cannot move
with respect to one another.

See Also PmitCadModelRefH | PmitError
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pmit_set_tolerances

Purpose
Syntax

Description

Input
Arguments

See Also

5-44

Set linear, angular, and relative tolerances of object of PmitCad2SMH
class

PmitError = pmit_set_tolerances(PmitCad2SMH pmitCad2SMH,
double linearTol, double angularTol, double relativeTol)

PmitError = pmit_set_tolerances(PmitCad2SMH pmitCad2SMH,
double linearTol, double angularTol, double relativeTol)
returns an error status PmitError.

With pmit_set tolerances, you can set the linear, angular, and
relative tolerances of an object of PmitCad2SMH class representing an
API-to-XML translator.

pmitCad2SMH

Handle object of PmitCad2SMH class representing an API-to-XML
translator

linearTol

Error tolerance when comparing linear alignments and spacings,
measured in length unit specified by PmitLengthUnit

angularTol

Error tolerance when comparing angular alignments and spacings,
measured in radians

relativeTol

Smallest significant relative numerical difference

PmitCad2SMH | PmitError | PmitLengthUnit | pmit_set_units



pmit_set_units

Purpose

Syntax

Description

Input
Arguments

See Also

Set units for API session

PmitError = pmit_set_units(PmitMassUnit massUnit,
PmitLengthUnit lenUnit)

PmitError = pmit_set_units(PmitMassUnit massUnit,
PmitLengthUnit lenUnit) returns an error status PmitError.

With pmit_set_units, you can set the units for an API session.

massUnit

Input of enumerated type PmitMassUnit specifying the mass unit
system

lenUnit

Input of enumerated type PmitLengthUnit specifying the length unit
system

PmitError | PmitLengthUnit | PmitMassUnit | pmit_set tolerances
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PmitVisMatProp

Purpose Structure type for defining visualized material properties of API CAD
object
Description PmitVisMatProp is a C language structure type.

You can define a variable of this type for any object in a SimMechanics
Link API CAD model. This variable specifies the visualized material
properties of the object, usually a part component of a CAD assembly.

You refer to the fields of the structure as PmitVisMatProp.field.
These are the structure fields and their possible values, which all range

from O to 1.
Field Values
rgb 3-vector [r g b] specifying red, green, and blue color intensities
r, g, and b
ambient Intensity of the ambient component of light falling on the component
diffuse Intensity of the diffuse component of light falling on the component
specular Intensity of the specular component of light falling on the component
shininess Shininess coefficient of the component’s material
transparency Transparency factor of the component’s material.
0 means the material is not transparent. 1 means it is fully
transparent.
emission Intensity of emission from the component’s material
See Also pmit_create_cadmodel | pmit_create_cadmodelref | PmitError
Related + OpenGL resources on visualized lighting and material properties

Links
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pmit_write_xml

Purpose

Syntax

Description

Input
Arguments

Output
Arguments

See Also

Tutorials

Write output of object of PmitCad2SMH class

PmitError = mit_write_xml(char** const pconstrainErroroOut,
PmitCad2SMH pmitCad2SMH, const char* filename)

PmitError = mit_write_xml(char** const pconstrainErrorOut,
PmitCad2SMH pmitCad2SMH, const char* filename) returns an error
status PmitError.

With pmit_write xml, you can write the output of an object of
PmitCad2SMH class to a Physical Modeling XML file.

pmitCad2SMH

Handle object of PmitCad2SMH class representing an API-to-XML
translator object

filename

String specifying the name of the XML file to which the API
representation is written

pconstrainErrorOut

String indicating constraint errors, if any, encountered while writing
the XML file

PmitCad2SMH | pmit_create_cad2sm | PmitError

+ “A Custom Exporter Module Example”
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